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REFERENCE





Graphic Workshop Professional embodies a great deal of functionality for managing and manipulating graphic images. It's unlikely that you'll find uses for absolutely everything Graphic Workshop knows how to do. It's more unlikely still that you'll want to try to learn everything there is to know about Graphic Workshop in a single session.





This document is an encyclopedic reference for all the functions of Graphic Workshop. 





If you have not already done so, please read the Introduction and Tutorial document installed with Graphic Workshop. It will walk you through the basic operation of the software and provide you with step by step procedures for performing the most common tasks that Graphic Workshop is called upon to do.





Note that throughout this document you will encounter references to configuring Graphic Workshop and using the Setup dialog. The configuration options and the Setup dialog are discussed in detail in the Configuration document.








About





Select About from the Help menu to see the About dialog for Graphic Workshop. If you're evaluating an unregistered copy of Graphic Workshop, you will no doubt be familiar with this dialog. It's worth noting that it will not appear when you exit a registered copy of Graphic Workshop, nor will it talk.





The About dialog will tell you which version of Graphic Workshop you're presently using, including the patch number if there is one. This information is important if you have cause to contact us with a bug report or a question about the software.





The About dialog also includes the most easily located secret screen in Graphic Workshop, should you be interested in such things. Click on the mermaid.








Associating File Types with Graphic Workshop





You can configure Windows 95 and Windows NT to run Graphic Workshop as an associated file viewer. This will allow it to view images when you double-click on them in Windows Explorer, for example. You must set up an "association" for each file type you want to have Graphic Workshop automatically view. 





You can set up file associations through the Association Wizard – just run the Association Wizard application and follow its instructions. You can also set up associations through Windows Explorer.





Using Association Wizard


The Association Wizard application will allow you to quickly associate one or more image file types with Graphic Workshop Professional. Having done so, you will be able to double-click on files of the associated types in Windows Explorer and Graphic Workshop will boot up and display the files in question. Note that in this mode Graphic Workshop will not display its conventional user interface – when you exit a viewed graphic in Graphic Workshop launched from Explorer, Graphic Workshop will terminate immediately.





Associated file types are also used by many other Windows applications. The Documents item of the Start menu uses file associations to decide which application to run when you select a recently opened document.





Note: Unlike Graphic Workshop itself, Association Wizard will make permanent changes to your Windows registry – it must do so to establish associations. These changes, once made, cannot be undone automatically. Previous associations which it overwrites are not preserved. If you wish to un-associate specific file types after you have run Association Wizard, you must do so through Windows Explorer. This is discussed in detail the Graphic Workshop Reference document.





If you run Association Wizard, you will see a list of most of the file types Graphic Workshop recognizes. Some of these will have check marks to the left of them. If you click on the Associate button, the file types with check marks will be associated with Graphic Workshop Professional.





Association Wizard defaults to selecting file types it thinks should be associated with Graphic Workshop. You're free to disagree with it – you can toggle the selection of any file type by clicking on its item in the Association Wizard window. Items which do not have check marks will not be associated with Graphic Workshop.





Some forethought and care is called for in using Association Wizard. Not all the file types Graphic Workshop knows how to work with should be associated with it. For example, you would probably not want to associate BMP files with Graphic Workshop if you like to be able to double-click on them and have them open in Windows Paint. 





The file types associated with Graphic Workshop do not affect the operation of Graphic Workshop itself – it will be able to view all the file types it supports through its user interface irregardless of what file types are associated with it.








Creating Associations through Windows Explorer


Here's how to set up an association for Graphic Workshop through Windows Explorer. In this example we'll associate it with the file type GIF.





1. Open Windows Explorer. You can do this quickly by clicking on the Start button with the right button of your mouse and selecting Explore from the menu that appears. Note that this procedure discusses Windows Explorer, not Microsoft Internet Explorer – clever of 'em to use the same name for two different applications.





2. Select Options from the View menu of Windows Explorer.





3. Click on the File Types tab.





4. Scroll down the list of file types and see if there's currently an entry for the file type GIF.





If there is no entry for GIF: click on the New Type button. Enter GIF Files in the Description of Type field and GIF in the Associated Extension field. Click On New. An entry for GIF Files will appear in the File Types list. Select the entry for GIF Files in the File Types list and click on Edit. The Edit File Types dialog will appear. Click on New. Click on Browse in the New Action dialog and navigate to the directory where Graphic Workshop is located. Select the GWSPRO.EXE file and click on OK. Make sure the DDE switch is off.





If there is already an entry for GIF: select it and click on Edit. The Edit File Types dialog will appear. Click on Edit. Click on Browse in the Edit Action dialog and navigate to the directory where Graphic Workshop is located. Select the GWSPRO.EXE file and click on OK. Make sure the DDE switch is off.





Repeat this procedure for each of the file types you wish to associate with Graphic Workshop.





Shareware users should note that the Graphic Workshop beg notice will appear each time Graphic Workshop views an associated image – this will not happen in registered copies of the software.
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The Graphic Workshop Caption function will allow you to add text to existing graphic files. Caption text always appears below the graphics it's added to, as it would in newspaper captions. The vertical dimension of a captioned graphic will be expanded sufficiently to allow for its caption text.





By default, if you have Graphic Workshop caption a file it will create a new file for you of the type you select and with "C_" prepended to its name. Thus PICTURE.GIF could be written to C_PICTURE.GIF, for example. This option can be disabled in Setup.





To add captions, select one or more files and select Caption from the Image menu. The Caption dialog will appear. The following items will affect what your captions look like:





Single Line: Enable this option to allow a single line caption – your caption text will be truncated when it fills the first line or at the first carraige return. Disable this option to allow multiple-line captions – your captions will include as many lines as they require to display all the caption text.





Background: Click on this colour button to select the colour your caption background will be set in. See the discussion of colour in captions, below.





Foreground: Click on this colour button to select the colour your caption text will be set in. See the discussion of colour in captions, below.





Frame: Click on this colour button to select the colour your caption frame will be set in. See the discussion of colour in captions, below. The frame will only be displayed if the Frame Size item is set to a value greater than zero.





Title Font: You can select any alphabetic single-byte TrueType font installed in your system as the caption text font.





Title Font Size: This is the point size of the caption text. Bigger point sizes will create bigger captions – if you enable the Single Line option, bigger point sizes will also allow fewer words in your caption.





Frame Size: Graphic Workshop's Caption function can display a coloured frame around your captions. The frame colour is set by the Frame colour button. Set this value to zero to disable the creation of a frame.





Justification: Select left, centre or right justifcation for your caption text.





Caption Text: The caption text field will allow you to enter up to 260 characters of caption text. You can use carriage returns to format your text if you wish. You can also instruct the Caption function to fetch text from a text file. To do this, enter an @ character followed by the path to your text file in the Caption Text field. This text file must be pure ASCII – not a formatted word processor document file. It can be of any length, but keep in mind that really huge files can create really huge graphics.





Once a caption has been applied to a graphic, the text in the caption is just pixels – it can't be subsequently edited with the Caption function. If you're careful, however, you can run the same graphic through Caption multiple times to add multiple captions in different colours or different fonts if you like.





Note that the Caption function draws its colours from a standard 256-colour palette. If you caption a 24-bit true-colour image, the colours you select will be displayed exactly as they appeared in the Caption dialog colour buttons. If you caption a graphic with 256 or fewer colours, the Foreground, Background and Frame colours you select will be matched to the nearest available colours in your graphic. This can result in visible colour shifts. If you caption two-colour graphics, make sure you choose colours which will remap to black and white correctly.





The Caption function will allow you to add visible captions to your images without mangling the pictures in question. Keep in mind that anyone determined to do so can subsequently remove them – the Graphic Workshop Crop function, for example, will excise captions. There is no practical way to embed text – such as a copyright notice – in your graphics in a form which guarantees that someone will not subsequently delete it.





The Caption button will not be visible if your system is configured with a 640 by 480-pixel screen driver. You can still access the Caption function through the Image menu.
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The Graphic Workshop Catalog function will create pictures of your pictures. Tag a number of images and select the Cataloging function. One or more files will be generated containing thumbnails of your selected images. These can be helpful in keeping track of a large collection of picture files.





Files created by the catalog function will be named Catalog00001, Catalog00002, Catalog00003 and so on. The catalog function will not overwrite existing files – if the file Catalog00001 exists, for example, it will begin with Catalog00002.





When you create a catalog you can select one of a number of sizes for the final catalog files, in eight or twenty-four bit colour, with the individual thumbnails set in either portrait or landscape frames. Choosing twenty-four bit colour will create more attractive catalog images.





If you create eight-bit catalogs you can choose to either remap or dither the thumbnail images. As a rule, remapped images won't represent the colours of your source graphics all that well and dithered images will lose a bit of resolution. Bayer dithering is faster than Floyd-Steinberg dithering, but the latter looks better.





Catalog files can be created with a three-dimensional appearance or with a flat white or black background. You can select the font to be used for file names – as this text is pretty small, it's unwise to use a particularly ornate font.





If you catalog animation files, such as AVI or FLI/FLC, the image cataloged will be the first frame in the file.








Clipboard





Graphic Workshop supports the Windows clipboard. Specifically, you can use it to copy images to the clipboard so other Windows applications can paste them into their documents. You can paste images currently on the clipboard into any image file format which Graphic Workshop supports.





There are two ways to get things onto the clipboard from within Graphic Workshop. To get an image from a file to the clipboard:





1. Select the file in question in a browser window.





2. Select Copy from the Edit menu. 





The file will be read and its image copied to the clipboard.





Alternately, you can choose the clipboard, rather than a specific file format,  as the destination for any Graphic Workshop function by clicking on the Clpbrd button in the Destination dialog. Thus, for example, you could "convert" a GIF files to the clipboard, or scale a JPEG file and have the scaled image copied to the clipboard. This would cause Graphic Workshop to read the file and write its contents to the clipboard, rather than to another disk file.





Note that if you use this function on a vector graphic, the object pasted to the clipboard will be a metafile, not a bitmap.





To fetch a bitmap from the clipboard and have it written to a file, select Paste from the edit menu. You will be prompted for a destination file. You can only Paste with Graphic Workshop if the object on the clipboard at the moment is actually a bitmap.








Configure EXE Pictures





Graphic Workshop for Windows can convert images in other graphic file formats, such as PCX and GIF, into executable pictures. When you run the executable files so created as applications, they'll display the your original images. Graphic Workshop can create both DOS or Windows applications, as defined by the Windows EXE Pictures switch in Setup. If you want to create EXE pictures which can be configured, as discussed in this section, the Windows EXE Pictures option must be enabled.





See the EXE section in the Formats document for more about Graphic Workshop's DOS-mode EXE pictures.





The Configure EXE Pictures item of the File menu will allow you to configure Windows EXE pictures created by Graphic Workshop.





Self-displaying pictures are limited to 256 or fewer colours. If you want to convert an image from a true-colour file to an EXE picture – such as a JPEG graphic – you must use the Colour Reduction option of the Effects dialog to reduce it to a 256-colour graphic, and select EXE as the destination format. Windows EXE pictures created by Graphic Workshop are useable as soon as they have been created. They default to fairly simple display parameters – you can modify these through the Configure EXE Pictures function.





Note: The Configure EXE Pictures function will not open anything other than a Windows EXE picture create by Graphic Workshop. If you attempt to open another sort of EXE file, such as an application, it will complain.





When an EXE picture has been opened in Configure EXE Pictures, its name will appear in the title bar of the Picture Configuration dialog and its dimensions, colour depth and the version of Graphic Workshop for Windows that created it will appear in the upper left corner of the Picture Configuration application window.





Keep in mind that configuring a Windows EXE picture will change the contents of the EXE file for the picture. If you have a virus detector that looks for modified EXE files, this will set it off. Doing so is harmless – no viruses have been introduced into your pictures.





Here's what the configuration options in Picture Configuration do:





Next Picture


Windows EXE pictures can chain to subsequent  pictures – or, in fact to any other application's EXE file – when they terminate. You can use this feature to create a Windows slide show. Click on Browse to select the picture to chain to. Delete the contents of this field to prevent a picture from chaining.





Note: If you want to abort a sequence of chained Windows EXE pictures when they're running, click and hold in the current picture with your right mouse button and click on the left button. A dialog will appear to ask if you want to abort the sequence.





Effect


Windows EXE pictures have built in multimedia facilities. A Windows EXE picture can play wave files, MIDI music files and Video for Windows AVI files. These have the file extensions WAV, MID and AVI respectively. You can configure a Windows EXE picture to play a multimedia file when it first starts up, or from a menu selection or a button in its About box.





Note that colour AVI files will seize the system palette for as long as they play on display devices having 256 or fewer colours. This may distort the colours of your Windows EXE picture until the movie stops.





You can select an effect file by clicking on Browse. Once an effect has been selected, click on Test to see what it sounds or looks like. While an effect is playing as a result of clicking on Test, the Test button will become a Stop button. Clicking on it will terminate the effect.





When a Windows EXE picture loads, it also looks to its command line for the path to a wave, MIDI or AVI file. If it finds one, it will use this as an effect if the Effect field has been left blank.





Title


This field allows you to define the text for the title bar of a Windows EXE picture. If you leave this field blank, the title will be "Picture."





Message


This field allows you to define the text for the About box of a Windows EXE picture. It can contain up to 300 characters.





Background and Set Background


If Set Background is enabled, the background of your picture will be the colour selected in the matrix of background colour tiles. If it's not enabled, the background will be the default background colour for the system that runs your EXE pictures. The background colour affects the matt around a picture when you maximize it. Click in a coloured tile to choose a new background colour. The current colour is indicated by a tile with a square within it.





Time Delay


If you enable Time Delay and enter a time delay value, your Windows EXE picture will display for a preset time and then automatically terminate or chain to another picture.





End On Mouse


If the End On Mouse option is enabled, clicking in a Windows EXE picture with your mouse will cause it to terminate or chain to another picture. This does not affect using the right mouse button to terminate a sequence of chained pictures.





Start With Effect


If the Start With Effect option is enabled, your Windows EXE picture will play an effect defined as soon as it runs if one was defined.





No Title Bar


The No Title Bar option will disable the title bar, system menu and the minimize and maximize buttons of a Windows EXE picture. It will only be enabled if End On Mouse or Time Delay are selected, such that there is some way to terminate your picture.





Centre Picture


The Centre Picture option will place your picture in the centre of its window when the window is maximized. If this option is not enabled the picture will appear in the upper left corner.





Maximize


The Maximize option will cause a Windows EXE picture to maximize automatically when it runs.





An unmaximized Windows EXE picture will generate a window just large enough to contain it. If you attempt to display a picture larger than your screen, Windows may be unable to create a window for it, and the image will not display. It's a good idea to keep the sizes of your Windows EXE pictures to modest dimensions.





EXE pictures created with an unregistered copy of Graphic Workshop Professional will say so when they're run. This message will not appear in EXE pictures created with a registered copy. This message cannot be removed once an EXE picture has been created – you must re-convert your graphic to EXE with a registered copy of Graphic Workshop Professional to banish it.





Distribution of EXE pictures created by Graphic Workshop: If you have registered Graphic Workshop Professional, you are welcome to create and distribute all the EXE pictures you like except in a commercial context wherein you are actually selling the service of creating EXE pictures. This assumes that you own the copyright to the images they contain, of course. EXE pictures created by an unregistered evaluation copy of Graphic Workshop may not be distributed.





Something weird in Windows: Windows does something very odd and apparently undocumented with EXE files. In creating the EXE picture function of Graphic Workshop, we discovered that if there's a FON file in your \WINDOWS\SYSTEM directory which has the same name as the EXE file you create, your EXE file probably won't run. This appears to be a characteristic of some older builds of Windows 95.





You're probably wondering what a FON file is. Files with the extension FON were used to store fonts in earlier versions of Windows. A system which has never had a version of Windows older than Windows 95 or Windows NT 4.0 will not have any FON files installed. If you have installed Windows 95 over Windows 3.1 in the past, however, some FON files may linger in your \WINDOWS\SYSTEM directory. In most cases, there will be three of them – ROMAN.FON, MODERN.FON and SCRIPT.FON.





If you were to create a self-displaying EXE picture called ROMAN.EXE and attempt to run it on a machine with ROMAN.FON in its \WINDOWS\SYSTEM directory, your EXE picture might refuse to do anything. This is also true of screen savers created by Graphic Workshop which have names corresponding to FON files.





Renaming your EXE picture will solve the problem.





This is also worth keeping in mind if you create EXE pictures or screen savers which you intend to distribute. While your system may have no FON files on it, some of the systems that your EXE pictures or screen savers are distributed to might. At the very least, avoid using the foregoing three names.





Because this appears to be an undocumented bug in Windows, it's unclear whether it might involves file types other than FON. If your EXE pictures or screen savers misbehave unexpectedly under older builds of Windows 95, try renaming them.








�embed Paint.Picture Object1 ��� Convert





Graphic Workshop will allow you to convert file of any format into files of any other format – with a few restrictions. The new file will have the same name as the original but a new extension. Converting PICTURE.GIF into a PCX file, for example, will create PICTURE.PCX. PICTURE.GIF will not be affected.





You can batch-convert any mixture of file types using Graphic Workshop. Any files which are inappropriate for the conversion you've requested will be ignored. The ongoing status will appear in the progress window.





You cannot convert pictures having more bits of colour than the destination format can handle. For example, you cannot convert a 24-bit JPEG file directly to an 8-bit GIF file. You would have to use the Effects colour-reduction facility to do this. Likewise, use  the Dither function to convert a colour file to a format which only accepts monochrome images.





You can convert between selected animated formats. You can also convert from an animated format to a still format – a dialog will appear allowing you to select the frame to convert. You can't convert from a still format to an animated format.





Note that Graphic Workshop will not convert between AVI and animated GIF files. See our GIF Construction Set software for this functionality. It's available at our web page, http://www.mindworkshop.com.





Not all the formats supported by Graphic Workshop are writeable. For example, you can convert from Photo-CD to JPEG, but not from JPEG to Photo-CD because Kodak wants serious bucks for its Photo-CD mastering software. Formats which cannot be written to do not appear in the Destination dialog.





If the format you want to convert a file to is disabled in the Destination dialog, one of two things has happened:





You are attempting to save an image to a format that doesn't support enough colours to store it.





The format in question has been switched off in the Formats dialog. Select Formats from the File menu of Graphic Workshop to re-enable it.





If you convert a file and select Clpbrd as its destination format, it will be pasted to the Windows clipboard and no actual destination file will be created. This is equivalent to selecting a file and selecting Copy from the Edit menu. If you convert a file to WllPpr, it will be converted to a BMP file, written to your \WINDOWS directory and configured as your current wallpaper image.
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The crop function will allow you to select areas of an image by dragging a rectangle around the bits you like with your mouse. Select Save As from the Picture menu to save the selected fragment to a new file. The Crop window may scale the image being cropped to fit in the window – cropped fragments will be written correctly.





You can fine-tune the cropping rectangle with the arrow keys of your keyboard. Hold down the left Shift key and use the arrow keys to move the left and top sides. Hold down the right Shift key and use the arrow keys to move the right and bottom sides. Use the arrow keys by themselves to move the rectangle.





If your source image has more colours than your Windows driver can display directly, you'll see a dithered approximation of your picture in the cropping window. Any fragments cropped from it will be saved with their original colour depth, however.





The title bar of a Crop window will display the location of your mouse cursor relative to the upper left corner of the image you're cropping and the dimensions of the cropping rectangle if one is visible.
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You can delete one or more files in a Graphic Workshop browser window by selecting each file to be deleted and then clicking on the Delete button, or selecting Delete from the file menu. A dialog will appear prompting you to confirm that you want to delete the selected files. Note that it will tell you how many files it proposes to delete. Make sure this number corresponds with the files you think you selected – it's not uncommon in working with large directories of files to have selected a few earlier and subsequently forgotten about them.





The Delete function can delete files in two ways:





It can remove them from your hard drive. Files thus deleted are gone for good and they cannot be subsequently recovered. 





It can send them to the Windows recycle bin. If you send files to the recycle bin and subsequently change your mind about their general unworthiness to continue existing, you can drag them back into a directory on your hard drive. The catch in using the recycle bin is that most graphic files are uncommonly large, and it's not at all difficult to tie up a lot of hard drive space by sending them to the recycle bin if you don't keep an eye on them. If you have the Recycle Bin option in the file deletion dialog enabled, make sure you empty your recycle bin frequently.
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Dithering is a sort of magical process by which colour images can be converted into pretty attractive black and white versions for reproduction on a monochrome screen or a black and white laser printer. 





Note that source files for dithering must have more than two colours. 





Dithering often works a lot better if you scale the original image up. Graphic Workshop lets you dither with images of anywhere from "size as" up to 500 percent expansion.





Note that the Dither function only dithers to monochrome. Colour dithering is handled by the Effects function.





By default, if you have Graphic Workshop dither a file it will create a new file for you of the type you select and with "D_" prepended to its name. Thus PICTURE.GIF could be written to D_PICTURE.GIF, for example. This option can be disabled in Setup.





The simplest and fastest form of dithering is Bayer dithering. This does not produce great results, but it's extremely quick. 





The remaining three dithering algorithms use what's called "error diffusion." These produce attractive dithers, but they're quite slow if they're applied to really large graphics. The fastest and least attractive is Floyd-Steinberg. The best and by far the slowest is Stucki. The Burkes dither is somewhere in the middle.





All three of these dithers come in two flavours, unidirectional and bidirectional. These options will produce slightly different results.





You should plan to experiment with the dithering options of Graphic Workshop a bit to see what it's capable of.





In dithering an image, the original brightness levels of the source graphic will be expanded a bit to improve the quality of the dither. The amount by which the grey levels are expanded is set by the Brightness and Contrast items in the Dither Options dialog. 





In addition to true dithering, the Dither function also provides for thresholding. This will reduce a colour or grey scale image to black and white by setting a white threshold. The results will usually be an exceedingly contrasty image. The higher you set the threshold value, the darker your new image will become. The threshold is point below which pixels in the source image will be considered to be black in the destination image.








Drag and Drop





You can Drag files into any Graphic Workshop browser window from Windows Explorer and other file drag sources. You can also drag selected files from a Graphic Workshop browser window to other applications which are Drag and Drop compliant, such as WinZIP. Finally, you can drag selected files between Graphic Workshop's browser windows. Note that you cannot drag files from Graphic Workshop to some versions of Windows Explorer, for reasons which Windows Explorer declines to explain.





By default, files dropped into a Graphic Workshop browser window will be copied to the directory it's looking at. Alternately, you can configure the default drop action in Setup to be:





Copy


Move


View


Prompt for one of the above.





Note that the Move function will delete the source files being dropped into a Graphic Workshop browser window once they have been copied.





If you hold down the Shift key when you drop files into a Graphic Workshop browser window, you will be prompted for a drop function no matter how you've configured Graphic Workshop. If you hold down the Ctrl key when you drop files into a Graphic Workshop browser window, the files will be moved function no matter how you've configured Graphic Workshop.





You can configure Graphic Workshop to prompt you before overwriting files through Setup. 





Graphic Workshop will only allow you to drop files into its browser windows if they're of types it recognizes.





If you drag files between Graphic Workshop's browser windows, the thumbnail THN files for your selected graphics will be moved or copied too, if they're present. If you drag graphic files from Graphic Workshop to another application, their THN files will not be included.
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The Effects function does colour reduction, remapping, dithering, conversion to grey scale, softening, sharpening and promotion to true colour. For a more extensive library of graphic effects, see the Filters option in the Picture menu of View mode.





By default, if you have Graphic Workshop apply effects to a file it will create a new file for you of the type you select and with "X_" prepended to its name. Thus PICTURE.GIF could be written to X_PICTURE.GIF, for example. This option can be disabled in Setup.





Colour reduction


The colour reduction function will create destination files with fewer colours than the source files they're derived from. You can use this function, for example, to reduce a 256-colour file down to a 16-colour one. It's particularly useful for 24-bit true-colour files to 256-colour files.





This is the function to use if you want to convert JPEG to GIF.





Whenever you reduce the number of colours in a graphic, some image information will get lost. The simplest form of colour reduction is "remapping". This means that the destination image will have the best colour palette it can, and that all the pixels in it will be replaced with colours from that palette. The results usually aren't very attractive.





Colour dithering can produce decidedly better results. With colour dithering you can reduce 24-bit files down to eight bits with very little loss of detail or colour resolution.





Colour dithering can work to either a quantized or a fixed palette. A quantized palette is one which is selected from the image itself. A fixed palette is one which is the same for all images. Colour reduction to a quantized palette is typically a lot more attractive.





The sixteen-colour fixed Windows palette should be used to create images which are to be used in a sixteen-colour Windows environment. Note that a lot of image quality will be lost in dithering to sixteen colours. The Graphic Workshop colour dithering functions have been fine tuned to improve the image quality when dithering to the fixed Windows palette. Specifically, the Floyd-Steinberg option will result in more attractive results for images with a lot of continuous tones – pictures of people, for example – while the Burkes and Stucki options will look better for images with larger areas of solid colour.





The 240 plus 16-colour palette consists of a 240-colour quantized palette followed by the sixteen-colour Windows fixed palette. If you select this option, your image will only be dithered or remapped to the first 240 colours.





The Custom palette option will allow you to choose the palette with which colour reduction or dithering will be performed. Click on the Select button and select a graphic file which contains the palette you'd like to use as the destination palette for your dithered or remapped graphics. Note that this selected file won't be altered – it will just be read as the source of a palette. The source palette file can be in any graphic file format supported by Graphic Workshop, but it must contain between four and 256 colours. Use the Get Info function to ascertain the number of colours in a file.





Grey scale


The grey scale function will create a grey scale destination image from a colour source image.





Sharpen


The sharpen function will create a destination image with more finely resolved details than its source image.





Soften


The soften function will create a destination image with less finely resolved details than its source image.





Smudge


The smudge function will create a destination image which looks like it's being viewed through water drops.





Spatial Posterization


The spatial posterization function will create a destination image in which the image is made up of large square tiles.





Promote to 24 Bits


The promote to 24 bits function will create a 24-bit file with the same image information as a source image having fewer colours. 








Formats





You can disable selected file formats in Graphic Workshop. When a format is disabled, no files of that type will appear in the Graphic Workshop file selector. Disabled formats can subsequently be re-enabled whenever you like. To enable or disable formats, select the Formats item from the File menu of Graphic Workshop. Click on the formats you wish to enable or disable. Enabled formats have an X beside them.
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If you select a file in one of Graphic Workshop's browser windows and click on the Get Info button or select Get Info from the Image menu, a dialog will appear to tell you about the file. The important things you'll probably want to know are the pixel dimensions and the colour depth of the image in your file. This can be handy, for example, if you want to ascertain whether a particular graphic will fit on your web page without having to be scaled down.





Get Information will tell you the following things:





The dimensions of your graphic in pixels.


The colour depth of your graphic, that is, the maximum number of colours it can support. This doesn't mean that it necessarily uses them all.


The packed size, that is, the number of bytes your graphic occupies as a disk file.


The unpacked size, that is, the amount of memory required to open it or process it.


The file type – which you probably already know, based on the file extension.


The amount of compression afforded by whichever file format the file is stored in. This number is somewhat meaningless for animation files.


Comments, which will vary between formats.





Some graphic file formats actually contain a lot more information than can be displayed in the normal File Information dialog. TIFF files, for example, can contain the name of the artist responsible for them, the type of software used to create them and so on. You can get at this optional information for formats which support it by clicking on the Details button in the File Information dialog if it's enabled





You may need some external assistance in fully interpreting the details of the more complex formats, such as TIFF. 





The File Information dialog will display a palette which represents the colours in your graphic. For true colour images, this will be a rainbow of colours ranging between black and white.





If you request file information for a graphic which has a Graphic Workshop thumbnail available, the thumbnail and its key words and comments will also appear in the File Information dialog.








GIF Construction Set UltraLight





The GIF Construction Set UltraLight software is a fairly extensive subject. It's dealt with in the GIF Construction Set UltraLight document.








GrafCat – Printed Graphic Catalogs





The GrafCat function will print high-resolution thumbnail pages with between six and 48 pictures per page. It's analogous to creating catalog images with the Catalog function and then printing them, save that it does so more conveniently and produces vastly more attractive results. The GrafCat function of Graphic Workshop Professional features a subset of the functionality of Alchemy Mindworks' stand-alone GrafCat software.





The GrafCat Options dialog includes the following controls:





Portrait mode frames, 16 per page: Causes your pictures to be printed sixteen to a page, with each image inset in a portrait mode frame.





Landscape mode frames, 15 per page: Causes your pictures to be printed fifteen to a page, with each image inset in a landscape mode frame. This mode will leave a blank left margin, allowing your pages to be bound.





Large squares, 6 per page: Causes your pictures to be printed six to a page, with each image inset in a square frame.





Small squares, 48 per page: Causes your pictures to be printed 48 to a page, with each image inset in a square frame. This mode will get the greatest number of images on a single page.





Two-Colour Dithered: This mode will cause your graphics to be dithered to two colours prior to printing. This will result in the nicest looking printed pages if you're using a dot-matrix printer.





256-level grey scale: This mode will cause your graphics to be printed as 256-level grey scale images, to be halftoned by your Windows printer driver. This mode will look dreadful if you have a Windows printer driver that doesn't do halftoning.





24-bit true colour: This mode should be used if you will be printing to a colour output device.





PrintBrighteness and PrintContrast: Adjust these values if you're using a black and white printer and find that your output is too dark or too flat respectively. This value only affects black and white printers.





DitherBrighteness and DitherContrast: Adjust these values if you're using the dithered monochrome printing option and the brightness or contrast of your printed pictures isn't correct. This value only affects printing in the Dithered Monochrome mode.





Matt Colour: This colour button will let you set the colour of the area inside each GrafCat frame which is not occupied by the image it contains.





Title Font: This combo box will let you select the font to be used to print the file names and titles on your pages.





Page Footer: This field will allow you to customize the text for the printed footer for each page. You can enter any text you like here, as well as the following macro symbols:





%P:  	page number


%D: 	date


%T: 	time


%S: 	time and date


%N: 	registered name


%A: 	program name


%V: 	volume name


%%: 	percent sign





These symbols will be replaced by the entities they represent wherever they appear in your footer text. So, for example, if your footer text is entered like this:





Page %P printed by %A registered to %N





it would print something like this:





Page 6 printed by Graphic Workshop Professional registered to Lancelot Pigswallow





This assumes, of course, that your name is Lancelot Pigswallow -- in which case you have a lot more important things to worry about than the GrafCat footer text.





Note: When it's confronted with one of GrafCat's complex pages, Windows can generate some fairly huge temporary files. Printing to a high resolution colour printer can require upwards of ten megabytes of free disk space per page for temporary files. Printing to a PostScript laser printer can result in temporary files of excess of 25 megabytes per page. If your pages refuse to print, free up some additional hard drive space.








Hardware and Software Requirements





Graphic Workshop Professional requires a Pentium or better processor to run. If you attempt to run it on a system with an 80386 or 80486 processor, it will refuse to boot.





A minimum of sixteen megabytes of memory are required to run Graphic Workshop Professional reliably, with 32 megabytes strongly recommended. Its performance will improve with increased memory. Note that if you run Graphic Workshop Professional on a system with numerous other large applications running concurrently – such that much of your system's memory is in use by other software – its performance may be degraded.





Graphic Workshop Professional can be used on systems with 256-colour Windows screen drivers, but doing so will typically not allow you to view most graphic images in their true colour depth. Graphic Workshop Professional will perform some functions noticeably slower on such systems. A high-colour or true-colour Windows screen driver is strongly recommended. See the Drivers document for a complete discussion of screen drivers and how to correctly configure yours.





If you have a system with a sixteen-colour Windows screen driver installed, do not attempt to run Graphic Workshop Professional on it. Graphic Workshop Professional may become so horrified by sixteen-colour Windows screen drivers as to run screaming from the room and require eleven to fifteen weeks of intense therapy and post-traumatic counseling. You have been warned.





Graphic Workshop Professional occupies approximately eight megabytes of hard drive space – you can recover about three megabytes by deleting all the help, documentation and example files. This is not recommended unless you store them elsewhere or have a breathtaking understanding of the software before you do so.





You can run Graphic Workshop professional under Windows 95, Windows 98 and Windows NT 4.0. It has not been tested under Windows NT 3.51 and it will not run under Windows 3.1 or Windows 3.11 with WIN32S even if you ask it really, really nicely.





Graphic Workshop Professional does not require any other specific software to be installed in order to operate per se – a few of its functions do use third party drivers which must be installed to support the functions in question. These are discussed as they appear throughout the documentation.








Identify Mystery Graphic Files





In order to deal with directories of graphic files reasonably quickly, Graphic Workshop makes the initial assumption that all the files it's asked to handle will have correct file extensions. For example, it assumes that JPEG files will have the extension JPG. A JPEG file with the extension GIF would not be readable.





In some cases – especially if you like to download graphics from the internet – you might encounter files which have obviously incorrect extensions, mysterious extensions or no extensions at all. You might also encounter files which Graphic Workshop can't read even though you're fairly sure that they're valid graphics – this is a good indication that the files in question have incorrect extensions.





Note that web browsers, such as Internet Explorer and Netscape, display the graphic files they support irregardless of their extensions. They can do this because they typically support fewer than half a dozen graphic formats. This can be a source of considerable confusion if your browser displays a file which purports to be a JPG graphic, for example, and Graphic Workshop will not. It's probably a file of another type which has been renamed with the JPG extension.





The Identify Mystery Files function in the File menu of Graphic Workshop will attempt to figure out the true nature of mysterious files. Specifically, it will compare the internal structure of a file of unknown type to the internal structures it knows how to deal with. If it finds a match, it will advise you of this and offer you the option of having the file in question renamed with its correct extension. It will thereafter be viewable by Graphic Workshop.





This process is mildly fraught with perils. It's possible to create files which will look like valid image structures, but which actually contain nothing but monkey dandruff. If you attempt to identify such a file, Graphic Workshop may erroneously tell you that it's something it isn't. Once Graphic Workshop tells you what a mystery file is, it's a very good idea to view it and make sure it's not pulling your leg.





Secondly, Graphic Workshop can only identify a subset of the file types it actually knows how to interpret. It won't do anything with mystery files in formats it doesn't recognize. It will also prove to be unable to recognize files in some of its supported formats if the formats in question don't actually have identifiable internal structures. For example, there's no reliable way to determine whether a mystery file is actually a MacPaint image because MacPaint files don't include identifiable structures. Graphic Workshop will not check mystery files to see if they're MacPaint files. 





For the most part, the formats that Graphic Workshop will read but doesn't check are fairly obscure ones.








Memory





Graphic Workshop expects Windows to supply it with the memory it requires. If insufficient memory exists to handle a file, it will say so. This is a bit awkward in that Windows does not provide a realistic way to ascertain how much memory is available. Graphic Workshop cannot know whether there's enough memory to unpack a specific graphic file until it tries.





If you attempt to perform a function which requires more memory than Graphic Workshop can allocate on your system, it will attempt to use a virtual memory spill file. This means that it will store your image on disk while it's being processed. Virtual memory is very much slower than real memory, and requires a lot of free disk space. It's a last resort when insufficient real memory is available. 





Not all the Graphic Workshop functions can use virtual memory. Specifically, if you attempt to rotate an image by 90° or 270° and virtual memory is required, Graphic Workshop will tell you that these functions cannot be performed. The View mode Filter functions and antialias scaling are also not available for virtual memory operations.





When virtual memory is used you'll see the message "Creating spill file" in the status window before each image is read.





Because virtual memory is very slow, you might want to disable it entirely. See the Configuration document for more about virtual memory.





Windows manages its available memory to attempt to provide memory to applications that need it in all but the most extreme cases. It does this by moving parts of itself or of other applications out of memory and onto your hard drive to satisfy requests for memory if things start getting a bit tight. Because hard drive access is much slower than memory access, causing Windows to resort to spilling things to disk will slow down the software running on your computer considerably.





If you open a really large graphic in Graphic Workshop, Windows may have to spill a lot of other things to disk to make room for it – very possibly including presently unused parts of Graphic Workshop itself. When you close the graphic, Windows will be able to recall some of its spilled objects back into memory. This can cause Graphic Workshop to drop into neutral right after you do something with a really big graphic and generate a lot of disk activity for a few seconds.





Note that in any discussion of Windows' available memory, the memory in question is real memory, not the virtual memory available by spilling things to your hard drive. 
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The Move and Copy Files function will copy files to another drive or directory, optionally deleting your source files when it's done. Specifically, Copy will copy files and leave your source files in place. Move will copy files and then delete your source files. In the latter case you'll be prompted to allow it to do so. The Move and Copy Files function includes optional verification of the copied files using a 32-bit CRC check. This reduces the likelihood of incorrectly copied files to something less than the odds of winning a state-run lottery.





Turn on the Prompt Before Overwrite option in Setup to prevent Move and Copy from overwriting existing files.





You can disable the prompt before moving files by turning off Prompt Before Moving Files in Setup.
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You can print one or more graphic files by selecting them in a browser window and clicking on the Print button, or by selecting Print from the Image menu.





Graphic Workshop's printing facilities will be determined by the printing capabilities of your currently selected printer and printer driver. It will print in colour, print to unusual output devices and so on if you have an appropriate driver installed in Windows. 





You can select the current printer by clicking on the Setup button of the Print Options  dialog. 





Printing can be handled using either Integral sizes or Scaled sizes. These work as follows:





Print at Integral Sizes: The Autosize option in the Print box will select one of the eight size options to best fill your page. Note that this will choose the best integral expansion factor – it will not scale your images arbitrarily to fill your page, as this could introduce scaling aberrations into them. The Integral Printing option will usually give you the best print quality, but not the best fit to your page.





Print with Scaling: The Scale to Fill the Page option will automatically size your printed image to fill the printable area of your page in one dimension. This will not include any printer margins. If this item is not selected, the printing size will be determined by the Scale Factor control – setting this value to 100 will print your graphic at precisely one pixel of your image to one pixel of your printer. This is usually very small. Setting it to 200 will double the size. Setting it to 50 will print at half size, a handy feature for creating your own postage stamps. The Print with Scaling option may introduce scaling aberrations into your graphics.





Note: in order to print correctly to some black and white laser printers, colour and grey scale images must be "expanded," that is, their grey scales must be adjusted to compensate for the non-linear grey scale of the output device. The amount of compensation varies among different laser printers. You can set it using the brightness and contrast controls in the Print dialog. The Expand Printed Halftones option must be enabled to do this.





The Center Printed Images item will center your pictures on the pages they're printed to.





Graphic Workshop will print in landscape or portrait mode – use the Setup button in the Print Options dialog to select the printer characteristics you require.





Graphic Workshop will optionally print a title for each file along with its image. You can specify the font you'd like it to use through the Title Font combo box in the Print Options dialog and the point size of the font to be used with the Font Size control.





The titles printed by Graphic Workshop can consist of text you supply and several macros. Enter your title text in the Title Text field. The macros expand to the name of your file, the date it was printed and so on, as follows:





%P: 	File path


%F: 	File name


%D: 	Printing date


%T: 	Printing time


%S: 	Printing time and date


%N: 	User name


%A: 	Application name


%%: 	Percent sign





You can enter up to 260 characters of text in the title field. Your final title may be longer than this due to macro expansion.





Here are some example titles and the text they will cause to be printed – these assume that you're printing EXAMPLE3.JPG and your name is Lancelot Pigswallow. Should the latter be the case, you have our sympathy.





%F			EXAMPLE3.JPG		


This is %F		This is EXAMPLE3.JPG


This is %F by %N	This is EXAMPLE3.JPG by Lancelot Pigswallow





You can specify the background colour for printed graphics with the Page Colour button in the Print Options dialog. Selecting a coloured background when you're printing to a black and white printer will print with a grey level. Keep in mind that if you select a fairly dark background, your printer will get through a lot of toner or ink.





Note that Graphic Workshop stores information about your printer in a file called PDEVMODE.BIN in the Graphic Workshop parent directory. Deleting this file with Graphic Workshop not running will restore your printer defaults. You may find this is necessary if you install a new printer.
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You can rename one or more files in a Graphic Workshop browser window by selecting each file to be renamed and then clicking on the Rename button, or selecting Rename from the file menu. The Rename function will prompt you for a new name for each selected file. If you attempt to enter a new name which contains characters that are not legal in file names, it will omit the errant characters.





Note that you cannot use the Rename function to change the file extension of an image file. If you were to attempt to rename EXAMPLE3.JPG to FlyingPurpleWombats.BMP, the renamed file would in fact be called FlyingPurpleWombats.JPG.





It's also worth noting that space characters are legal in Windows file names. As such, you could rename a file to Flying Purple Wombats.JPG.








Resource Extractor





Resource Extractor is an ancillary application included with Graphic Workshop. You can access it through its desktop icon, or by selecting Resource Extractor from the Graphic Workshop Professional section of the Programs menu. It cannot be accessed through Graphic Workshop itself.





Windows applications and the libraries they use are constructed of executable programs – the things your computer actually runs to make something happen – and chunks of data. These chunks of data are called "resources." Windows resources are structured to allow them to be accessed as discrete entities by the programs that use them. Resources can include things like graphics, icons, text, sounds and so on. Windows resources also include a lot of fairly technical objects, such as dialog templates and accelerator tables, which will be if little interest if you don't actually write Windows software. These latter entities will not turn up in this discussion.





The nature of Windows resources is that they can be accessed by applications other than the ones that own them. Using suitable software, it's possible to open a Windows executable file or library, browse the resources therein and copy the ones you like to new files.





One of the most commonly accessed Windows libraries in this regard is the file MOREICON.DLL, which can be found in your \WINDOWS directory. This is a library of Windows desktop icons. You can use this library to replace the icons of common Windows applications if you want to customize your Windows desktop.





Resource Extractor is a tool for snooping around in Windows executable files and libraries to search for icons, graphics, sound and text resources. It will allow you to browse through files having the extensions EXE, DLL and VBX. If you find resources you like, you can save them to disk.





Resource Extractor will save graphics to BMP files, icons to ICO files, string tables to TXT files and binary data to BIN files. If it encounters binary data which is in fact a Windows sampled sound, it will save the resource to a WAV file. In a Windows application, binary data is any collection of stuff that Windows can't think of a better name for. With the possible exception of Windows WAV files stored as resources, most binary data only makes sense to the applications that own it, and can safely be ignored.





To use Resource Extractor, run the Resource Extractor application and select Open from the File menu. Locate a suitable EXE, DLL or VBX file. The file will open in Resource Extractor and present you with a list of resource types in the left part of the Resource Extractor main window.





There are several potential problems Resource Extractor can encounter upon opening a file:





The file is not a standard Windows executable or library: This means that you have attempted to open a file which Resource Extractor doesn't recognize as being a Windows application. It could be a DOS application or an OS/2 application, for example, or it could be corrupted.





The file appears to be corrupt or there was a problem allocating memory: This usually means the file is damaged. A damaged file can confuse Resource Extractor into thinking it requires enormous amounts of memory to unpack it.





There are no interesting resources in the file you attempted to open: The oddest things interest software. This message means that there are either no resources at all in the file you attempted to open – not an unheard-of situation – or that none of them are graphics, icons, text or binary data.





When Resource Extractor has successfully opened a file, it will display a tree which lists each of the resources it finds. Click once on any resource to view it. Select Save As from the File menu or the right-click menu to save the selected resource to a file. If the selected resource is a sound stored as binary data, the Play item in the File menu and in the right click menu will be active – select Play to heard the sound.





Keep in mind that Resource Extractor only reads the applications and libraries it opens – it cannot change them. As such, you can extract resources 'til your mouse melts without any risk of damaging any of your applications or system files.





You can turn Resource Extractor loose on any EXE, DLL or VBX files on your hard drive. The \WINDOWS, \WINDOWS\SYSTEM and \Program Files directories are a good place to start looking for things to try it out on.





Legal dogma: In browsing through applications and libraries on your hard drive, you'll probably find some interesting graphics and quite a few icons to make your desktop more colourful. As long as the things you find stay on your hard drive, no one is likely to complain about this. Note, however, that the icons, graphics and other resources Resource Extractor can locate are typically copyrighted entities belonging to the developers of the software in question. Distributing these objects to someone else or modifying them for commercial use would be a clear violation of said copyright – as well as being unethical, doing so offers a fairly good possibility that someone's lawyer will show up at your digs and start chewing on your leg.





Important: Resource Extractor makes calls to the main executable file of Graphic Workshop Professional. It will not run if it's moved to a directory other than that of GWSPRO.EXE, or if it's distributed without the rest of Graphic Workshop. If you register Graphic Workshop Professional by entering your registration code and name in the Graphic Workshop Setup dialog, Resource Extractor will not recognize the code until you have exited Graphic Workshop once. Registered users of Graphic Workshop Professional will not see Resource Extractor's beg notice when it runs.
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The reverse function will create a reversed version of any image file. 





By default, if you have Graphic Workshop reverse a file it will create a new file for you of the type you select and with "R_" prepended to its name. Thus PICTURE.GIF could be written to R_PICTURE.GIF, for example. This option can be disabled in Setup.





If you reverse a colour image, Graphic Workshop will create a colour negative. These look weird – we haven't found a use for them as yet.








Rotator





The Rotator application can be used to have Windows change your wallpaper and your screen saver periodically. It can be configured to change one or both every time windows boots up, or once a day.





When Graphic Workshop is installed, two Rotator icons will be created. The second one is titled Rotator (drag to StartUp) – this icon must be moved to the StartUp group of your Windows desktop before Rotator will operate. To do this:





1.	Locate the Rotator (drag to StartUp) icon in the Graphic Workshop Professional shortcut group.





2.	Use the right button of your mouse to click on the Start button of your Windows taskbar.





3.	Select Open from the short menu that appears.





4.	Double click on the Programs group in the Start Menu window.





5.	Locate the StartUp group in the Programs window and double click on it.





6.	Drag the Rotator (drag to StartUp) shortcut icon to the StartUp window.





You can now close the StartUp, Programs and Start Menu windows.





The remaining Rotator shortcut icon can be used to configure Rotator. Double click on it to access the Rotator application window. The Rotator application will show you two lists – the leftmost list contains all your current Windows wallpaper. The rightmost list contains all your current Windows screen savers.





There are three options at the top of each of the lists in the Rotator application window. These tell Rotator how often to rotate the items in question. They are:





Never: Rotator will never rotate the selected items, and will make no changes to your current Windows configuration.





Daily: Rotator will rotate the selected items once a day, the first time Windows is started up. If you have to start Windows a second time on the same day, Rotator will not change anything.





Always: Rotate will rotate the selected items every time you start Windows.





Note that if Never is selected, the list of items it pertains to will be disabled. You must select Daily or Always to access the items in one of Rotator's lists.





Click on a list item to toggle its status. Items marked with an X will be included in the rotation. You can have as many selected items as you like.





You can preview a list item by right-clicking on it. The right-click dialogs will also let you configure the items in question. If you right-click on a wallpaper item, you'll see a preview of the wallpaper graphic and you'll be able to specify whether the wallpaper should be displayed on your desktop centered or tiled. If you right-click on a screen saver item, you'll see a preview of the screen saver and you'll be able to configure the wait time before the screen saver activates. While Rotator will allow you to rotate sixteen-bit Windows 3.1 screen savers, it will not display anything in its preview window if you right-click on one.





Note that Rotator only saves the configuration values for selected items in its lists. As such, for example, if you set a wallpaper item to display as tiled but it's not selected – that is, if there's no X in the check box in its list item – it will not have the Tiled option selected in its right-click dialog the next time you run Rotator.





You can force Rotator to step through its rotations with the Rotate Wallpaper and Rotate Screensaver items in its File menu. The lists corresponding to these menu items must have their rotation options set to Daily or Always to activate these items.





While it's not necessary to understand what Rotator is up to use it, here's how it works, should you be curious.





The Rotator (drag to StartUp) shortcut icon differs from the Rotator shortcut icon in the Graphic Workshop Professional shortcut group in that it has /R appended to its command line. When the Rotator application runs and finds this command line argument, it knows to rotate through its lists and then terminate immediately.





Any application with a shortcut icon in the StartUp shortcut group will be automatically run every time Windows starts up. This gives Rotator the opportunity to change your wallpaper and screen saver. 





The Rotator shortcut icon in the Graphic Workshop Professional shortcut group does not have a /R in its command line, and as such it allows Rotator to start normally and display its application screen.





Rotator's configuration items, including the names of the wallpaper files and screen savers in its rotator, are stored in a file called GWPROTR.INI in your \WINDOWS directory.





Important: Rotator makes calls to the main executable file of Graphic Workshop Professional. It will not run if it's moved to a directory other than that of GWSPRO.EXE, or if it's distributed without the rest of Graphic Workshop. If you register Graphic Workshop Professional by entering your registration code and name in the Graphic Workshop Setup dialog, Rotator will not recognize the code until you have exited Graphic Workshop once. Registered users of Graphic Workshop Professional will not see Rotator's beg notice when it runs.
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The Scale function will allow you to scale files up or down by percentage, or to specific sizes. Select By Factor to scale files by a percentage or By Size to scale pictures to the dimensions of your choice.





By default, if you have Graphic Workshop scale a file it will create a new file for you of the type you select and with "S_" prepended to its name. Thus PICTURE.GIF could be written to S_PICTURE.GIF, for example. This option can be disabled in Setup.





In pathological cases scaling a picture can produce some really ugly results, depending on what you scale. Bear in mind that scaling by integral values – down to seventy five or fifty percent, up to two hundred percent and so on – will produce less ugly results than scaling by arbitrary values.





The scaling values you enter will be rounded to the nearest lower integral value. Thus, 42.5 percent will really be 42 percent.





You should avoid scaling dithered monochrome pictures. Nothing technically bad will happen, but for reasons which will become obvious if you think about it, the results will almost always be horrible enough to mutate bacteria.





Note that the scaling percentage you enter determines the size of the destination image relative to the source image. Thus, entering 25 will produce a destination image which has dimensions one quarter – 25 percent – of the original image. Entering 200 will create a destination image twice as big – 200 percent – of the original. Entering 100 will produce a destination image identical to the source image.





By default, scaling by factors will be the same in both dimensions. If you select the Anamorphic option you'll be able to enter independent horizontal and vertical values.





You can also scale pictures to a specific size. If you select the By Size option and then enter dimensions in pixels into the Dimensions fields, Graphic Workshop will calculate the appropriate scaling factors to make you pictures come out to the size you've selected.





The fixed size buttons in the By Size group will allow you to quickly select commonly used image sizes. They set the Dimensions fields to their indicated values.





The Maintain Aspect option will allow you to scale to a fixed size image without changing the aspect ratio of your graphics. It will cause your image to be scaled such that one dimension fills the indicated frame and the other dimension is scaled by the same factor. For example, if you were to scale a 320 by 200 picture to 800 by 600 with this option enabled, the resulting image would be 800 by 500 pixels. The longest dimension, 320, would be scaled to 800 pixels. The shortest dimension, 200, would scaled by the same factor as the longest dimension.





The minimum size for scaling by size 16 pixels. 





The Interpolated / Integrated Scaling option will cause Graphic Workshop to apply some image processing to scaled images if it's enabled. It only works for true-colour and grey-scale graphics – it will be ignored if you attempt to scale a monochrome or palette image.





When you scale a graphic up, its pixels are in a sense moved apart and additional pixels are generated to fill the gaps between them. This can be handled in one of two ways. The simplest one – and by far the fastest – is to duplicate the existing pixels in the source image to fill the gaps. This can result in a final graphic which looks like a Roman mosaic, with a small number of large, visible pixels.





The second approach to scaling a picture up is to generate the required new pixels as a smooth transition between the existing pixels. This is called "interpolation" or "anti-aliased scaling." The results are much more attractive, but they take longer to achieve. 





Having said this, for graphics of moderate size and a fast computer, the difference in processing time will be significantly less than that required to read the foregoing paragraphs and realize that a difference exists at all.





In scaling a graphic down, some of the pixels in the source image have to be removed, and hence some of the detail will be lost. As with scaling up, this can be handled in one of two ways. Graphic Workshop can just remove the required pixels and send them into the eleventh dimension, or it can average all the pixels to be removed to generate the new pixels for the scaled-down image. The first case is faster, while the second one typically looks a lot better. Averaging the source pixels is called "integration", or, once again, "anti-aliased scaling."





Interpolated / integrated scaling is a usually two-pass process – you'll see the status bar move twice for each image being scaled. It also requires lots of memory, and unlike conventional scaling, its memory requirements increase with the final size of your scaled image. If you use interpolated / integrated scaling to scale large pictures up to make still larger pictures, Windows might have to do a lot of internal memory management. This can often take a long time and result in considerable hard disk activity. Be patient.





Note that if you promote a palette-colour image to 24 bits or convert it to a grey-scale image and then run it through interpolated / integrated scaling, some really peculiar image artifacts will probably appear in the final scaled graphic.





Should you want to create thumbnail graphics for a web page, the Graphic Workshop scaling function is the place to be. Here's how to do it:





1. Select your source images and select the Scaling function. 





2. Select the By Size option in the Scaling dialog.





3. Enter rectangular dimensions for the frame in which you'd like all your thumbnails to reside. If you enter 96 by 96, for example, Graphic Workshop will create thumbnails of the same dimensions as the ones it displays in its browser windows.





4. Click on OK and select JPG as the destination format.





You might want to switch off the File Name Underbars option in Setup and write your thumbnail JPG files to a different directory to keep the names constant.
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Graphic Workshop can acquire images through a TWAIN device. The TWAIN interface is typically used by scanners, but it's also applicable to digital cameras and other image generators with TWAIN drivers. Note that your system must have suitable TWAIN drivers installed for your scanner to use the Acquire function of Graphic Workshop – scanners which are not TWAIN-compliant are not supported by the software.





If the Acquire function in Graphic Workshop is disabled, your TWAIN driver could not be located.





Note: A few scanners have semi-compliant TWAIN interfaces which Graphic Workshop does not get along with. If you can't scan through Graphic Workshop's Acquire function, check your scanner setup. Failing this, contact your scanner manufacturer to see if there's an updated driver set available.





To scan a graphic using Graphic Workshop, click on the Acquire button or select Acquire from the Image menu. A dialog will appear to drive your scanner.





The Acquire dialog is resident in your TWAIN driver and is not part of Graphic Workshop. Its contents will vary with the capability of your scanner. Consult your scanner documentation for a discussion of its use. It will also probably look cosmetically different from the rest of Graphic Workshop.





When you have completed a scan, Graphic Workshop will prompt you for a destination format and a file name to save it to.





Graphic Workshop accepts the images your scanner created and writes them to files with no correction or modification. Some TWAIN drivers offer options that can be used to create pretty ugly images. This is especially true of what purport to be 256-colour scanning modes. If you want to scan graphics and wind up with 256-colour image files – such as to write your pictures to GIF files – you should scan into 24-bit true-colour files and then use the colour reduction features of Graphic Workshop's Effects function to reduce your source images to 256 colours.





When Graphic Workshop boots up, it looks for a TWAIN_32.DLL to load as its TWAIN driver. It must reside in \WINDOWS, in \WINDOWS\SYSTEM or in Graphic Workshop's parent directory for it to be located.





Note that many TWAIN drivers hang pretty reliably if you attempt to scan something with your scanner switched off. This will usually require that you reboot your system to re-initialize the driver.





If you have multiple TWAIN devices in your system, you can choose the one you want to scan with by selecting Select Source from the Image menu or by holding down the Shift key and clicking on the Acquire button.





Note that Graphic Workshop does not use virtual memory to scan. If you want to scan a twelve-megabyte image, your system must have at least twelve megabytes of available physical memory.








Screen Capture





Graphic Workshop Professional Camera is an ancillary application to capture all or part of a Windows screen to a PCX file. You can capture the entire screen, the currently active window or just the client area thereof. The PCX files created by Camera can be converted to any other format you like using Graphic Workshop itself.





When it's running, Camera will capture screens in response to a predefined combination of keys. You can choose the activation key combination from a list of key combinations.





To get Camera ready to capture screens, run it from its desktop shortcut icon or from the listing in the Programs section of your Start menu. You can configure it by double clicking on its task bar icon.





Here's what the items in the Setup dialog do:





File Path and Base Capture File Name: These items define the directory where your screen capture files will be written, and  the file name to be used to store them. The file names will have sequence numbers appended to them. As such, if the File Path is set to C:\GraphicWorkshopProfessional and the Base Capture File Name is set to Capture, the first time you invoke Camera to capture a screen, a file called Capture00001.PCX will be created in the directory C:\GraphicWorkshopProfessional. The next time you ask Camera to capture a screen the file will be called Capture00002.PCX, and so on.





Camera checks each potential file name before it uses it. As such, it will not overwrite existing files. The file numbers can range from one through 32767 – although if the file number gets anywhere near this large, you should plan on a fairly lengthy wait between captures. You'll probably also need a few extra gigabytes of hard drive space to hold all the files.





If the Auto Create Thumbnail switch in the Graphic Workshop Professional Setup dialog is enabled, Camera will create thumbnails for the images it writes.





Alternate PCX Files: This item defines how sixteen-colour screen capture PCX files should be written. This will only matter if you're using a sixteen-colour Windows screen driver – happily there are few of these left in captivity. If you enable this item, sixteen-colour PCX files will be written in a format which is faster for some Windows applications to unpack, but which are not compatible with most DOS applications that read PCX files. If you have a Windows screen driver made after the late middle ages, you can ignore this setting.





Window to Capture: This item selects the area of your screen for Camera to capture. If you select Whole Screen, the whole screen will be captured – perhaps not surprisingly. Active Window will cause Camera to capture the topmost window on your screen. Active Client will cause Camera to capture the client area of the topmost window. Note that Camera will complain if you use one of the latter two options and the topmost window is the Windows task bar.





Activation key: This list will allow you to select the combination of keys that will cause Camera to capture a screen. Note that some applications trap some of these key combinations for their own use. If you can't capture a screen in a particular Windows application, you may have to select another key combination.





Time Delay: If this value is set to a value greater than zero, Camera will wait for the specified number of seconds before it captures your screen. It will beep once per second. This is useful for capturing menus that disappear as soon as you hit a key, or dialogs which trap all the key strokes that Camera recognizes. You can tell Camera to capture a screen and then get the menu or dialog in place before it goes off.





When you activate Camera to capture a screen, it will beep and your cursor will turn into an hourglass while the capture file is being written. When the capture is complete, the cursor will resume its previous appearance and Camera will beep again.





All the information in the Setup box will be saved when close Camera. They're stored in a file called GWSPCAM.INI in your \WINDOWS directory.





Note: Camera cannot capture a full-screen DOS session. It also cannot capture a DOS window unless you set it to capture the whole screen. This is unfortunate – it's just the way Windows works.





Important: Camera makes calls to the main executable file of Graphic Workshop Professional. It will not run if it's moved to a directory other than that of GWSPRO.EXE, or if it's distributed without the rest of Graphic Workshop. If you register Graphic Workshop Professional by entering your registration code and name in the Graphic Workshop Setup dialog, Camera will not recognize the code until you have exited Graphic Workshop once. Registered users of Graphic Workshop Professional will not see Camera's beg notice when it runs.








Screen Savers





Windows screen savers are actually specialized applications which are run automatically by Windows when your system has been idle for a predetermined time. Screen savers have the file extension SCR.





Graphic Workshop will convert graphics in other formats to screen savers. In fact, when you perform this conversion, Graphic Workshop creates an application to display your pictures as screen savers and embeds your graphic in the application. Graphic Workshop's screen savers can be run on systems which do not have Graphic Workshop installed on them – they are self-contained screen savers.





Graphic Workshop screen savers can be configured to display your graphics with a number of animated transitions. Users of these screen savers can define which transitions they'd like to see.





Having converted a graphic to the SCR format with Graphic Workshop, you must copy the SCR file you have created to your \WINDOWS directory. Alternately, simply have Graphic Workshop write it directly to \WINDOWS. Open the Windows Control Panel and select Display. Click on the Screen Saver tab and select GWSPRO Screen Saver as your default screen saver. Click on the screen saver Setup button to access the screen saver configuration dialog.





Graphic Workshop's screen savers can display graphics with your choice of one or more of the following animated transitions. If you disable all these options, your graphics will appear and disappear with no animation.





Chaos and Order: Your graphics will appear as a sequence of random tiles which are gradually sorted into their correct order.





Horizontal Split: Your graphics will appear to split horizontally and move together.





Plummet: Your graphics will appear as vertical bands which descend into your screen area.





Quadrants: Your graphics will appear in four sections which resolve into a complete image.





Sandstorm: Your graphics will appear one pixel at a time, in random order. 





Tile: Your graphics will appear one tile at a time, in random order.





Vertical Split: Your graphics will appear to split vertically and move together.





Wipe in from Left: Your graphics will wipe in from the left.





Wipe in from Right: Your graphics will wipe in from the right.





The Setup dialog will also allow you to set the image duration – the time your graphics will be displayed between animated transitions – and the Random Placement switch. The latter option can be enabled to cause your graphics to appear at a different location every time they're displayed, or disabled to centre them.





The Test button in the Setup dialog will display your screen saver as it will appear when your screen is actually blank. Click anywhere in the screen to end the test. This feature is duplicated by the Preview button in the Windows Display under Windows 95, 98 and NT applet – it's included here for users of Windows 3.1.





Screen savers created with an unregistered copy of Graphic Workshop Professional will say so when they're activated. This message will not appear in screen savers created with a registered copy. This message cannot be removed once a screen saver has been created – you must re-convert your graphic to SCR with a registered copy of Graphic Workshop Professional to banish it.





Note that in addition to converting graphics to the SCR format, Graphic Workshop will convert images from its own SCR format back to other, more conventional graphic formats. To this end, it can display SCR files in its browser windows. Graphic Workshop will only read and convert from SCR files it has created – if you attempt to have it read an SCR file from another source, it will most likely display an error message. Be warned – if you inquire about why Graphic Workshop displays error messages when it's asked to read SCR files it's never heard of, we will, however reluctantly, be forced to send a leather-winged demon of the night to search the very threads of time for the beating of your heart and breath all over you until your hair falls out.





The screen savers created by Graphic Workshop are sixteen-bit Windows applications, which means that they can be used under Windows 3.1, Windows 95, Windows 98 and Windows NT. This also means that you will not see an animated preview in the Display applet of the Windows Control Panel when you select one, and the Password button will be disabled. Password Protection is available for Graphic Workshop's screen savers, but it's handled through the Setup dialog.





Graphic Workshop screen savers store their defaults in a file called GWSPSAVE.INI in your \WINDOWS directory.





Distribution of screen savers created by Graphic Workshop: If you have registered Graphic Workshop Professional, you are welcome to create and distribute all the screen savers you like except in a commercial context wherein you are actually selling the service of creating screen savers. This assumes that you own the copyright to the images they contain, of course. Screen savers created by an unregistered evaluation copy of Graphic Workshop may not be distributed.





If you'd like to set up complex multimedia screen savers, see Alchemy Mindworks GraphSaver application, available at our web page.








Secret Screens





There are five secret screens in Graphic Workshop Professional. They include information about some of the iconography and background for the software. There's nothing in them which will be of any use in actually running Graphic Workshop. You might want to see if you can find them all should you feel adventurous one day.





As a rule, the secret screens are accessed by clicking on various graphic images that appear in Graphic Workshop's dialogs – in some cases with the Shift, Ctrl or Shift and Ctrl keys held down. Good hunting.





It would be irresponsible of us not to mention that most of the secret screens include details from classical paintings, some of which depict subjects without a lot on. If this sort of thing bothers you, you should probably leave the secret screens a secret.





If you're just dying to see the secret screens and you can't find them all, you can cheat. The locations of all five of them are listed here in white text. The background of this document being white, it will be a little hard to read. However, if you highlight the apparently blank space below and change the colour to black, you'll see the directions to find the secret screens.





Secret the First: Go to the Help menu and select About. Click on the mermaid. This one's pretty easy.





Secret the Second: Go to the Help menu and select Tip of the Day. Hold down the Shift key and click on the butterfly.





Secret the Third: Enable the startup window in Setup if it's not already enabled. Exit Graphic Workshop and restart it. When the startup window appears, quickly hold down the Ctrl key and click on the unicorn.





Secret the Fourth: This one's well hidden. Maximize Graphic Workshop if it's not currently maximized. Click on the program icon in the title bar to open the System menu. Hold down the Shift and the Ctrl keys and select Restore.





Secret the Fifth: Point a browser to the parent directory of Graphic Workshop. Select EXAMPLE3.JPG and then select Get Info from the Image menu. Hold down the Shift key and click on the thumbnail image.








�embed Paint.Picture Object1 ��� Selecting Files





Graphic Workshop processes the files that are selected in the topmost browser window. It offers a number of ways to select files. It's useful to know about these – they'll save you a lot of time if you want to work with directories containing large numbers of graphics.





You can select files:





One at a time, by clicking on their names


In groups, by clicking on the first file in the group to be selected, holding down the Shift key and clicking on the last file in the group to be selected. All the intervening files will be selected.


By clicking on the Tag All button in the button bar or by selecting Tag All from the File menu, which will select all the files in the current directory.


By holding down the Shift key and clicking on the Tag All button. Graphic Workshop will prompt you to enter a wild-card specification for files to select. For example, if you enter T*.GIF, all the GIF files having names which begin with the letter T will be selected. If you enable Clear Existing Selections, any presently selected files will be unselected before your wild-card selection is processed. Note that you can call this function multiple times to tag files corresponding to different wild-card specifications.





Having selected some files, you can subsequently unselect them by:





Clicking on the individual file names to be unselected.


Clicking on the first file in the group to be unselected, holding down the Ctrl key and clicking on the last file in the group to be unselected. All the intervening files will be unselected.


By clicking on the Clear button in the button bar, which will unselect all the files in the current directory.


By holding down the Shift key and clicking on the Clear All button. Graphic Workshop will prompt you to enter a wild-card specification for files to unselect.





Note that the current number of selected files in the topmost browser window will be displayed in the Graphic Workshop status bar.








�embed Paint.Picture Object1 ��� Setup





The setup and configuration options for Graphic Workshop are a fairly extensive subject. They're dealt with in the Configuration document.








�embed Paint.Picture Object1 ��� Slide Show





Graphic Workshop will display selected graphics in a continuous slide show. While hardly as sophisticated as a presentation package, the slide show function is an easy way to view a collection of images while you sit back in your chair and test the tensile strength of its springs.





To use the slide show function, select several images in a browser window and click on the View button, the one with the sunglasses. A small menu will appear. Click on the slide option. You can also select Slide Show from the Image menu. The Slide Show Options dialog will appear.





You can configure Graphic Workshop's slide show to display each image for whatever duration you like. You can configure the background colour and the font Graphic Workshop will use to display the name of each file in the slide show – assuming that you want the file names displayed at all. You can also enable the Zoom option, which will automatically scale files too large to fit on your screen down to size. Note that zooming only scales the image being displayed – it will not actually change anything in your source graphic files.





If you enable the Loop option, your slide show will run indefinitely until you interrupt it – rather like the vacation photographs from hell that still flicker and ooze from traditional slide projectors around the world. If the Loop option is not enabled, your slide show will stop when it runs out of images.





Click on OK to start the slide show.





Once a slide show has begun, you can interrupt it by hitting the Esc key or by clicking with the right button of your mouse. You can also have it proceed immediately to the next slide by hitting Enter.





The slide show function will skip animation files.








System Information





The System Information dialog will provide you with an overview of the configuration of your computer. This can be useful in unraveling configuration issues. It includes the following:





Screen Width and Screen Depth: These are the dimensions in pixels of your current screen display mode. 





Network Present: If this field is set to Yes, Windows is of the opinion that your computer is connected to a network of some sort.





Slow Machine: This field indicates Windows' assessment of the speed of your computer.





Windows Version: This is the internal version number for your installation of Windows.





Machine Owner: This is the owner name used when you installed Windows.





Organization: This is the organization or company name used when you installed Windows.





Colour Depth: The last item in the System Information dialog indicates the number of colours which your current Windows screen driver can display without dithering. If this number is 256 or less, Graphic Workshop Professional is running a lot slower and looking a lot uglier than it needs to. See the Drivers document for help in reconfiguring your Windows screen driver.








�embed Paint.Picture Object1 ��� Thumbnails


The thumbnail mode of Graphic Workshop is a convenient way to select files to work with. In thumbnail mode you can see small previews of each file in your current directory, in addition to the file names. This makes it easier to see what files look like before you open them. It also means, however, that you'll be able to see fewer files at a time.





Each browser window can display the names of the files it sees in one of four modes. These modes are:





Small text – just the file names


Normal text – just the file names plus a grey document icon


Small thumbnails – the file names plus small thumbnail images


Normal thumbnails – the file names plus normal thumbnail images





By default, Graphic Workshop will open browser windows in the latter mode. You can change this once a browser window has been open, and you can configure Graphic Workshop to use a different default mode for new browser windows if you like.





You can change the browser mode of a browser window by clicking on the Thumbnail button in the Graphic Workshop tool bar. A small menu will appear with four icons – a large thumb and a small thumb for normal and small thumbnails and a large "A" and a small "A" for normal and small text. Select the mode you want your browser window to show you. You can change this mode whenever you like.





Note that you can also create multiple browser windows pointing at the same directory but in different modes and just switch between browser windows, rather than changing modes, if you like.





The current browser mode is remembered between sessions, along with the window size and position, for each open browser window.





If you point a Graphic Workshop browser window at a directory of your own graphics, you'll probably see a field of the grey thumbnail symbols. Because thumbnails take a few seconds to create and they occupy space on your hard drive, Graphic Workshop will not create them unless you tell it do so. Here's how to create a thumbnail.





1. Click once on the graphic you'd like to have a thumbnail for. This will select the file.





2. Select Add Thumbnail from the Thumbnail menu.





A thumbnail should appear for the selected graphic after a brief pause.





Adding thumbnails, like all the other image processes Graphic Workshop can do, can be done with more than one file at a time. If you select more than one file and add thumbnails as was discussed above, all the selected files will have thumbnails created for them.





Note: If you hold down the Shift key and click on the Thumb button, the Add Thumbnails function will be invoked as if you'd selected Add Thumbnails from the Thumbnail menu.





Thumbnails are stored on your hard drive in one of two forms:





As THN files: These files have the name of the graphic files they're associated with and the extension THN. As such, if you add a thumbnail to the file PICTURE.JPG, the thumbnail will reside in a file named PICTURE.THN. Thumbnails are always stored in the same directory as the graphic files they refer to.





As records in the thumbnail database: Graphic Workshop maintains a file called GWSPRO.TDB in its parent directory which keeps track of thumbnails in the event that you don't want to use individual THN files.





There's a complete discussion of the Thumbnail Database elsewhere in this document. Graphic Workshop defaults to maintaining its thumbnails as THN files – you will probably want to leave it configured this way unless you have a specific reason for changing it. Be sure to read the Thumbnail Database section completely before you do so.





If Graphic Workshop maintains its thumbnails as THN files, the thumbnail for PICTURE.PCX will also be PICTURE.THN. Files in different formats will share the same thumbnail. This helps conserve disk space, but it could cause you some confusion in using the comments and key word features of the thumbnails, as discussed elsewhere in this document. As there is little reason to keep multiple copies of the same image in the same directory, you probably needn't worry about this.





You can have Graphic Workshop automatically create new thumbnails for files it writes to disk by enabling the Autocreate Thumbnails option in Setup.





You cannot use thumbnails or the Details and Search features for Kodak Photo-CD PCD files, MPEG and MOV movies or WAV and MIDI files.





Here's what the Thumbnail menu options do:





Add Thumbnails


If you select one or more files and then select Add Thumbnails from the Thumbnail menu, thumbnail images will be created for each of the selected images. These will replace the default grey thumbnail symbol. Note that if you add thumbnails to images which currently have thumbnails, new thumbnails will be created for them and any key words and comments previously associated with the images in question will be discarded.





Add Thumbnails Where Required


This function behaves like Add Thumbnails, save that it will not create thumbnails for images which already have them.





Remove Thumbnails


The Remove Thumbnails function of the Thumbnail menu will remove the thumbnail images, comments and key words for all the selected images. The thumbnail images will be removed from all the browser windows looking at the directory in question, to be replaced by grey thumbnail images. 





Keywords and Comments


The Keywords and Comments function of the Thumbnail menu will allow you to add comments and key words to selected images. This information will actually be stored in THN thumbnail files associated with the images in question.





You can store anything you like in the Comments field of the Keywords and Comments dialog. The key words should contain information to search by. For example, in adding key words to pictures of animals, you might use key words such as BIRD, AMPHIBIAN, INSECT, ELEPHANT, POLITICIAN and so on. 





Search for Keywords


The Search for Keywords function of the Thumbnail menu will allow you to search through all the images with thumbnail entries in your current directory for specific  key words. Any entries which match the key words you specify will be selected. You can subsequently view, print, examine or change the details and otherwise perform the usual Graphic Workshop batch functions on them.





If you enter more than one key word into the Thumbnails Search box, you can select how the search should treat them using the And and Or options. With And selected, only those entries having all the key words you've entered will be matched. With Or selected, any entry having at least one of the key words you've entered will be matched.





If you disable the Clear Tags before Search option, any currently selected entries will be left selected by the search. 





You can search for partial matches of keywords if you enable the Partial Matches option in the Search dialog. Thus, for example, you could find all the wombats by searching for WOM or BAT. This option can be used in conjunction with the And and Or functions.





View


The View submenu will allow you to select which of the four view modes discussed earlier should be used for the current browser window. It has the same function as the menu which appears when you click on the thumb button.





Thumbnail Database


The Thumbnail Database is discussed in detail elsewhere in this document.








Thumbnail images can be dithered or not, as you prefer. See the Configuration document for more information about selecting a thumbnail dithering option. You can configure Graphic Workshop to use your choice of images for the symbol which appears when no thumbnail is present. This is also discussed in the Configuration document.








Thumbnail Database





By default, Graphic Workshop stores thumbnails in files with the extension THN, as discussed in the Thumbnails section of this document. This can present Graphic Workshop with two specific problems, to wit:





It can't store thumbnails on existing CD-ROMs, and as such graphics on CD-ROMs can't be browsed with thumbnail images. As least, they can't if the thumbnails are to be handled as THN files.





Because THN files apply to all the images with the same name as the THN file in question, different graphics in the same directory having the same name but different formats will display the same thumbnail even if they in fact contain different images. This is a somewhat unlikely occurrence in the normal application of Graphic Workshop.





The thumbnail database option of Graphic Workshop addresses these issues. If you configure Graphic Workshop to store its thumbnails in the thumbnail database, rather than in individual THN files, all your thumbnails will be maintained in a file called GWSPRO.TDB in the Graphic Workshop parent directory. Each entry in the database includes a thumbnail and the path, volume name and serial number of the drive it's located on. As such, when Graphic Workshop wants to display a thumbnail, it can be instructed to look in the database, rather than looking for THN files which correspond to your pictures.





This gets around the issue of Graphic Workshop not being able to write THN files to CD-ROMs, as all its thumbnails will be written to the GWSPRO.TDB database file stored on your hard drive.





There are several considerations to keep in mind if you enable the thumbnail database.





Accessing thumbnails from the thumbnail database will get progressively slower as the database gets larger. On a fast system this probably won't become noticeable until you have several thousand of thumbnails in the database.





When Graphic Workshop updates or deletes a thumbnail from the thumbnail database, it does not actually remove it. Because manipulating the database to remove records is very time consuming, it just marks the deleted records and thereafter ignores them. To keep your thumbnail database from growing to truly enormous dimensions, it's necessary to compact it from time to time, to remove the deleted records. This will be discussed in detail in a moment. Compacting the database isn't difficult – it's just something you'll need to do from time to time if you enable the thumbnail database options.





If you delete a graphic file which is referenced by the thumbnail database through an application other than Graphic Workshop, Graphic Workshop won't know that it's been deleted and its thumbnail will remain as an orphan in the database until you compact it.





As noted earlier, the thumbnail database can display different thumbnails for images having the same file name but different extensions.





The thumbnail database is usually a bit more efficient of disk space than individual THN files are. The reason for this is a bit technical. Careful examination of the size of GWSPRO.TDB will disclose that one record of the database is actually about half a kilobyte larger than one THN file. However, hard drive space is allocated in "granules" – a file which is one byte larger than one granule occupies two granules, even though most of the second one contains no data. Graphic Workshop's THN files typically occupy three four-kilobyte hard drive granules, for a total of about twelve kilobytes, whereas a thumbnail database record occupies about eleven kilobytes. If you're working with a lot of half-megabyte image files, the extra one kilobyte of space probably won't concern you greatly.





Note: Because the thumbnail database stores information about the location of each file it references, manually moving your graphics around or changing the volume name or serial number of the drives where they're stored will usually invalidate their entries in the database. If this happens, they will no longer display with thumbnails until you add new thumbnails for them. 





You can configure and maintain Graphic Workshop's thumbnail database through the Thumbnail Database item of the Thumbnail menu. Here's what its options do:





Reading Thumbnails





Only Check Disk: Graphic Workshop ignores the thumbnail database when it looks for thumbnails and only retrieves them from THN files.





Check Disk, then Database: Graphic Workshop looks for thumbnails as THN files and only checks the database if it doesn't file a suitable THN file. Enable this option if you assign thumbnails to images on your CD-ROMs. Note that doing so does impose a small but measurable speed penalty on Graphic Workshop's browser windows when they're in a thumbnail mode and they encounter directories on your hard drive with images having no THN files.





Only Check Database: Graphic Workshop ignores any THN files which might be present when it wants to display thumbnails, and only looks in the thumbnail database. This option isn't recommended unless you have a very good reason to use it.





Writing Thumbnails





Write to Disk: Graphic Workshop ignores the thumbnail database when it creates thumbnails and only writes them to THN files. If it can't write a THN file, as in the case of graphics on a CD-ROM, no thumbnail is created.





Write to Database: Graphic Workshop never creates THN files, but stores all its thumbnails in the thumbnail database. This option will typically leave you with a really enormous GWSPRO.TDB file, and isn't recommended unless you have a very good reason to use it.





Write to Database if Disk Fails: Graphic Workshop attempts to create THN file when it wants to store thumbnails and only writes them to the database if it can't write a THN file. Enable this option if you wish to display thumbnails for graphics stored on CD-ROMs.





Preserve Unique File Extensions: If this option is enabled, Graphic Workshop will display unique thumbnails for each file in a directory even if files exist having the same names with different extensions.





Compact Now: Click on this button to compact the thumbnail database. Compacting the database will remove any deleted records and any records which reference files that can't be found on your system. 





Include Removable Drives: If this option is enabled, the compacting process will check for the existence of graphic files referenced by the database even if they exist on CD-ROMs, floppies or network drives. If it finds that they don't exist, it will remove their entries from the database. You should disable this option to compact the database if you have added thumbnails to the database for graphics on CD-ROMs, floppies or network drives which are not on line when you click on Compact Now.





The database compacting function copies the records of your thumbnail database to a new file, ignoring those records which are to be removed. There must be enough free hard drive space on the drive where your Graphic Workshop parent directory is located to create a temporary file as large as the original GWSPRO.TDB file or the compact function will fail.





Note: If you have CD-ROMs of graphics created by Alchemy Mindworks – our graphic collections or the graphics included with the Alchemy Mindworks software installation CD-ROM – you will not need to enable the thumbnail database to see thumbnails for these images. Our CD-ROMs are created with THN files for each of the available images.








Tool Bar





The Graphic Workshop tool bar provides access to most of the functions supported by the software. All its buttons duplicate functions available in the main menu, but buttons are easier to get at than menus. The tool bar buttons have associated tip windows – if you forget what a button does, place your mouse cursor over it for a moment and a window will appear to explain its function.





The functions dispatched by the tool bar always pertain to the topmost browser window if you have multiple browsers open. The tool bar buttons which process files will be disabled if no files are selected in the topmost browser window.





Here are all the tool bar buttons. Each of these functions is explained in detail elsewhere in this document.





�embed Paint.Picture Object1 ���	Convert: Converts selected files to a different format. 


�embed Paint.Picture Object1 ���	Crop: Crops rectangular areas from existing images. 


�embed Paint.Picture Object1 ���	Dither: Dithers colour images to black and white.


�embed Paint.Picture Object1 ���	Effects: Performs colour reduction, colour dithering and other colour processes.


�embed Paint.Picture Object1 ���	Get Information: Displays file information.


�embed Paint.Picture Object1 ���	Print: Prints selected files to your printer.


�embed Paint.Picture Object1 ���	Reverse: Reverses selected files to negative images.


�embed Paint.Picture Object1 ���	Scale: Resides selected files.


�embed Paint.Picture Object1 ���	Transform: Rotates and mirrors selected files.


�embed Paint.Picture Object1 ���	View: Accesses a sub-menu for the View and Slide Show functions. Hold down the Shift key and click on this button to go directly to the Slide Show dialog.


�embed Paint.Picture Object1 ���	Catalog: Generates image catalog files, or "contact sheets."


�embed Paint.Picture Object1 ���	Tag All: Selects all the files in the topmost browser window.


�embed Paint.Picture Object1 ���	Clear All: Unselects all the files in the topmost browser window.


�embed Paint.Picture Object1 ���	Delete: Deletes the selected files, or sends them to the recycle bin.


�embed Paint.Picture Object1 ���	Rename: Renames the selected files.


�embed Paint.Picture Object1 ���	Setup: Accesses the Setup dialog for Graphic Workshop.


�embed Paint.Picture Object1 ���	Help: Accesses the Help function for Graphic Workshop.


�embed Paint.Picture Object1 ���	Exit: Exits Graphic Workshop.


�embed Paint.Picture Object1 ���	Thumbnail: Accesses a sub-menu to select the file display mode for the topmost browser window. Hold down the Shift key and click on this button to add thumbnails to all the selected files in the topmost browser window.


�embed Paint.Picture Object1 ���	Directory: Changes directories. You can do the same thing with the directory tree in Graphic Workshop's browser windows. If your computer is connected to a network, you'll probably find that Graphic Workshop is a lot faster if you configure it to only display the drives in your local computer in its directory trees, and use the Directory button in the tool bar to access network drives. Hold down the Shift key and click on the Directory button to refresh the directory tree and file list in the topmost browser window. Hold down the Ctrl key and click on the Directory button to move up one level in your current directory.


�embed Paint.Picture Object1 ���	Move and Copy: Moves and copies selected files to another drive or directory.


�embed Paint.Picture Object1 ���	Acquire: Acquires images through a TWAIN-compliant scanner or other input device. Hold down Shift and click on the Acquire button to select the scanner source.


�embed Paint.Picture Object1 ���	Caption: Adds text captions to graphic files.








�embed Paint.Picture Object1 ��� Transform





The transform function will rotate an image in ninety degree increments or mirror it horizontally or vertically. These functions work on images with any number of colours. 





By default, if you have Graphic Workshop transform a file it will create a new file for you of the type you select and with "T_" prepended to its name. Thus PICTURE.GIF could be written to T_PICTURE.GIF, for example. This option can be disabled in Setup.





The 90° and 270° rotate functions cannot be used with virtual memory.





Note that the Transform function can only rotate files in 90-degree increments. If you'd like to rotate an image by a smaller amount, use the Transform function in View mode, as is discussed elsewhere in this document.








�embed Paint.Picture Object1 ��� View and Filters





If you double click on a file name or select one and then click on the View button, Graphic Workshop will open a View window and display the selected file. Select multiple files and click on the View button to show several files one after another. 





Note that the View button is located in a small menu that appears when you click on View in the tool bar.





If the picture you have selected is larger than your screen, you can use the cursor movement keys and the View window scroll bars to pan around it. Hold down the Shift key when you hit a cursor key to move in larger increments.





To exit a display window, you can do any of the following:





Hit Enter or Esc on your keyboard. If you have selected multiple files to view at once, Enter will display the next file and Esc will abort any further files and return you to the main screen. 





Open the Picture menu in the View window and select either Next or Cancel. If you have selected multiple files to view at once, Next will display the next file and Cancel will abort any further files and return you to the main screen. 





Right-click with your mouse and select Next or Cancel from the menu that appears.





Graphic Workshop can be configured to close its view windows as soon as you right-click in one, and not display the right-click menu.





By default, Graphic Workshop's display windows will size themselves to fill your screen. You can configure Graphic Workshop to create display windows which are sized to the dimensions of each graphic you view if you like.





You can delete files from within View mode either by selecting Delete from the Picture menu or by hitting the Del key on your keyboard. If you hold down the Ctrl key and hit Del, you will not be prompted to confirm that you wish to delete the file in question. Once a file has been deleted, View mode will automatically terminate and display the next selected file if there is one. If you want to sort out a lot of files, select them all, click on the View button and use this feature to kill the ones you don't want to keep. Note that files deleted through View mode are handled the same way as files deleted directly from a browser window. See the section of this document which deals with deleting files for more about this.





If your graphic requires more colours than your current Windows screen driver can display, Graphic Workshop will display a dithered version of it. Graphic Workshop will use an eight-colour dither if you have a sixteen-colour display and a 256-colour dither if you have a 256-colour display. These dithers have been optimized for speed rather than for image quality, although the 256-colour dither can look pretty respectable as dithers go.





This assumes that Graphic Workshop has not become horrified by your sixteen-colour Windows screen drivers and run screaming from the room, requiring eleven to fifteen weeks of intense therapy and post-traumatic counseling, as discussed elsewhere in this document.





Many graphic files include file comments, which may tell you about more about the pictures stored in your files or explain their copyright. You can configure Graphic Workshop to display file comments through the Setup dialog.





You can perform a variety of image processes on graphics in the View mode by selecting the Filters item from the Picture menu. The Image Filter dialog will appear – select the filter type you wish to use and adjust its parameters accordingly. Click on Preview to see what the effect of your parameter selection looks like, and on OK when you're happy with the results. The scroll bars around the example image will let you see different areas of your adjusted graphic. The button to the lower right of the example image will return to the center of your graphic.





Graphic Workshop regards images to be filtered as being of four types:





Monochrome images, which have two colours.


Palette images, which have between four and 256 colours.


Grey scale images, which have 256 levels of grey


True colour images, which have sixteen-million colours.





Some filters are only available for specific image types and will not appear if you attempt to filter an image for which they are not applicable.





Note: 256-colour photorealistic images got that way by being dithered from true-colour images. If you promote them to true colour, a lot more of the filters will be available to work with them. However, doing so does not undither them and you'll probably find some pretty strange things happening when you try to filter them. Be warned. The same is true if you convert a dithered 256-colour image to grey scale.





Here are all the available filters:





Average: softens images.


Blurr: blurrs images.


Colour and Intensity: allows you to interactively adjust the colour and intensity of an image.


Contrast and Brightness: allows you to adjust the contrast and brightness of an image.


Convert to Grey: converts images to grey scale.


Convert to Mono: dithers and thresholds images to two colours.


Convert to RGB: promotes images to true colour.


Edge Trace and Fatten: traces the edges of monochrome images or fattens their details.


Emboss: creates embossing effects.


Enhance Edges: locates the edges of objects in image sand makes them more noticeable.


Equalize: interactively redistributes the shadows and highlights of images.


Obscure: makes images look like they're about to enter the witness protection program.


Reverse: makes negatives.


Scale: resizes images. See the Scale section of this document for more about scaling.


Sharpen: sharpens images.


Transform: flips and rotates images. Use the Free Rotate option to rotate an image in increments of less than 90 degrees.


Water Drops: makes image look like they're being viewed through water drops.


Waves: adds waves to images. This one can look truly weird.





The Free Rotate feature of the Transform filter allows for rotation by any angle from zero through 360 degrees in one-degree increments. It will rotate either clockwise or counter-clockwise. 





Note that because free-rotating will result triangular margins around your rotated image, you can select the destination image background colour in this mode. The background colour is used to fill the margins. Click on the Background colour button to select a background colour. The available background colours are drawn from the image palette for images with 256 or fewer colours. True colour background colours can be selected from an evenly dispersed 256-colour palette.





Free rotation looks pretty reasonable when it's applied to grey scale and true colour images – applying it to dithered images can introduce some aberrations into your rotated graphic.





Free-rotating an image will usually leave it with at least slightly jagged edges.





By default, the size of a rotated image will be increased to allow the whole image to be included. The Preserve Size feature of the Free Rotation function will crop the destination image to fit within the dimensions of the source image.





Rotation always takes place around the centre of the source image, and is rotated to the centre of the destination image.





You can save a filtered picture to a new file by selecting Save As from the Picture menu. 





The Filters option is not available for images which have been unpacked into virtual memory.





The Undo item in the Picture menu will be active once you have used the Filter function. It will undo the most recent filter operation.





Note that if you want to apply more than one filter to the image, you must invoke the Filter function multiple times.





Softening and then sharpening a scanned graphic with the Filter function is an effective technique for reducing scanning moirés.





You can get information about an image while you're in View mode by selecting Get Info from the Picture menu.





If you're viewing a small image, select Tile from the Picture menu to have it duplicated over the entire view window. This is handy for seeing what tiled BMP files will look like if you use them as wallpaper, and for viewing web page background textures.





The View menu in a View window will allow you to select the degree of magnification at which your image will be displayed. Zooming in on an image – increasing the magnification – will effectively increase the size of its pixels, and the displayed image will get chunkier the more you zoom in. The Zoom to Fill item in the View menu will select the appropriate magnification level to best fill your display window.





By default, Graphic Workshop opens graphics in View mode at a magification level of 100 percent. You can change this in Setup such that it defaults to any View magification level you like, or to Zoom to Fill.





